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Abstract


EOSView is a file viewing tool developed for the ECS project for the examination and 
verification of HDF and HDF-EOS data files. This tool enables the user of EOS data products to 
view the contents of HDF files and individual objects by being able to read and display all 
metadata fields and data objects appropriately. Supported record types for viewing and display 
capability include images, Raster images, multidimensioal arrays, text, tables, (Vdatas) and 
Vgroups. Attributes and annotations can also be viewed. EOSView users will see the 
underlying HDF structures and will be prompted for which parts of the structure they wish to 
view. 

The EOSView application is able to convert HDF and HDF-EOS data files to a particular type, 
ASCII and binary, for storage on a user’s disk space so that the user can then make further use of 
analysis and visualization tools already available in commercial public domain systems. 
EOSView is then able to open and provide the means for ingesting HDF and HDF-EOS files into 
other software systems. 

Keywords: EOSVIEW, HDFEOS, VDATAS, HDF, images, point, swath, grid 

iii 445-TP-006-002 



This page intentionlly left blank. 

iv 445-TP-006-002 



Contents


Abstract 

1.  Introduction 

1.1 Identification ..................................................................................................................1-1


1.2 Scope ..............................................................................................................................1-1


1.3 Purpose and Objectives ..................................................................................................1-1


1.4 Status and Schedule........................................................................................................1-1


1.5 Document Organization .................................................................................................1-2


2. Related Documentation 

2.1 Parent Documents ..........................................................................................................2-1


2.2 Related Documents ........................................................................................................2-1


3. Overview of HDF and HDF-EOS 

3.1 Introduction ....................................................................................................................3-1


3.2 HDF and HDF-EOS File Formats..................................................................................3-1


3.2.1 Overview ............................................................................................................3-1


3.2.2 Structure of an HDF-EOS File ...........................................................................3-2


4.  Environment, Installation and Maintenance 

4.1 Introduction ....................................................................................................................4-1


4.2 Download Instructions ...................................................................................................4-1


4.3 Notes...............................................................................................................................4-2


4.3.1 Approved Platforms ...........................................................................................4-2


4.3.2 Interfaces and Data Types ..................................................................................4-2


v 445-TP-006-002 



4.3.3 Tunable Parameters ............................................................................................4-3


4.3.4 Environment Variables.......................................................................................4-3


4.3.5 Special Constraints.............................................................................................4-3


4.3.6 Command Line Interface....................................................................................4-3


4.4 User Feedback Mechanism ............................................................................................4-3


5. EOSView User Interface 

5.1 Introduction ....................................................................................................................5-1


5.2 Quick Start Using EOSView and GUI Overview ..........................................................5-2


5.2.1 Invoke EOSView................................................................................................5-2


5.2.2 EOSView Main Screen ......................................................................................5-2


5.2.3 EOSView File Selection Dialog.........................................................................5-4


5.2.4 File Contents Display Pop-up ............................................................................5-5


5.2.5 Numeric Data Group ..........................................................................................5-5


5.2.6 Surface/Contour Plot .........................................................................................5-11


5.2.7 Jump To Dialog.................................................................................................5-16


5.2.8 File Save Dialog ................................................................................................5-17


5.2.9 Make Image From Table Data...........................................................................5-18


5.2.10 Image Display ...................................................................................................5-20


5.2.11 Lat/Lon Symbol Pop-up....................................................................................5-22


5.2.12 X-Y Cursor Window .........................................................................................5-24


5.2.13 ScanLine Cursor Window .................................................................................5-25


5.2.14 Vdata .................................................................................................................5-25


5.2.15 VGroup..............................................................................................................5-29


5.2.16 Raster Image......................................................................................................5-29


5.2.17 EOSView Grid Select GUI ...............................................................................5-32


5.2.18 EOSView Swath Select .....................................................................................5-38


5.2.19 Point Files..........................................................................................................5-42


5.2.20 Pulldown Menus................................................................................................5-45


5.2.21 File Pulldown Menu..........................................................................................5-46


5.2.22 Options Pulldown Menu ...................................................................................5-46


5.2.23 Window Pulldown Menu ..................................................................................5-48


5.2.24 Attributes Pulldown Menu ................................................................................5-49


vi 445-TP-006-002 



5.2.25 Help Pulldown Menu ........................................................................................5-50


5.2.26 Save Pulldown Menu ........................................................................................5-54


List of Figures 

5-1. EOSView Main Screen ......................................................................................................5-3


5-2. File Selection Dialog..........................................................................................................5-4


5-3. EOSView File Contents Pop-up ........................................................................................5-6


5-4. Multi-Dimension SDS Pop-up...........................................................................................5-7


5-5. Dimension Information Pop-up .........................................................................................5-8


5-6. EOSView “sol_azimuth” Table Pop-up............................................................................5-10


5-7. EOSView Contour Plot Pop-up ........................................................................................5-11


5-8. Contour/Surface Data Range Pop-up................................................................................5-12


5-9. Contour/Surface Data Value Pop-up.................................................................................5-13


5-10. Contour/Surface Min/Max Range Pop-up ......................................................................5-14


5-11. EOSView Stats Pop-up ...................................................................................................5-15


5-12. Jump To Dialog...............................................................................................................5-16


5-13. File Save Dialog..............................................................................................................5-17


5-14. Min/Max Values Pop-up.................................................................................................5-18


5-15. “sol_azimuth” Image Display Pop-up ............................................................................5-20


5-16. Lat/Lon Symbol Pop-up..................................................................................................5-23


5-17. X-Y Cursor Pop-up .........................................................................................................5-24


5-18. Scanline Cursor Pop-up ..................................................................................................5-25


5-19. File Contents Pop-up Containing Vdata ........................................................................5-26


5-20. EOSView - Vdata Field Select Pop-up...........................................................................5-26


5-21. Table containing Vdata field Pop-up ..............................................................................5-27


5-22. Plot Pop-up .....................................................................................................................5-28


5-23. File Contents Pop-up containing Vgroups......................................................................5-29


5-24. File Contents Pop-up containing Raster Images.............................................................5-30


5-25. Raster Image Pop-up.......................................................................................................5-31


vii 445-TP-006-002 



5-26. Grid File Contents Display Pop-up.................................................................................5-32


5-27. Grid Select Pop-up..........................................................................................................5-32


5-28. Grid Information Dialog Pop-up.....................................................................................5-33


5-29. Projection Information Pop-up .......................................................................................5-34


5-30. Grid Dimensions Pop-up.................................................................................................5-35


5-31. Grid Data Fields Pop-up .................................................................................................5-35


5-32. Start/Stride/Edge Pop-up ................................................................................................5-36


5-33. Warning Dialog...............................................................................................................5-37


5-34. Attributes Text Display Pop-up ......................................................................................5-37


5-35. SwathFile File Select Pop-up..........................................................................................5-38


5-36. Swath Selection Pop-up ..................................................................................................5-39


5-37. Swath Geolocation Mappings Pop-up ............................................................................5-40


5-38. Swath Indexed Mappings Pop-up ...................................................................................5-40


5-39. Index Mapping Sizes Pop-up ..........................................................................................5-41


5-40. Swath Geolocation Fields Pop-up...................................................................................5-41


5-41. PointFile File Contents Pop-up.......................................................................................5-42


5-42. Point Select Pop-up.........................................................................................................5-43


5-43. Point File Level Information Pop-up ..............................................................................5-44


5-44. Vdata Table Pop-up ........................................................................................................5-45


5-45. File Information Dialog ..................................................................................................5-46


5-46. Animation Window Pop-up ............................................................................................5-47


5-47. EOSView Main Screen Showing Window Pulldown Menu ..........................................5-48


5-48. Text Display Pop-up .......................................................................................................5-49


5-49. EOSView On Help Pop-up .............................................................................................5-50


5-50. Help On Contents Pop-up ...............................................................................................5-52


5-51. Help On Index Pop-up ....................................................................................................5-53


5-52. Help On Version Dialog .................................................................................................5-53


viii 445-TP-006-002 



List of Tables 

4-1. Operating Systems .............................................................................................................4-2


4-2. Environment Variables ......................................................................................................4-3


5-1. Common ECS Operator Functions Performed with EOSView (1 of 2) ...........................5-1


5-2. EOSView File Selection Field Description .......................................................................5-4


5-3. Multi Dimension SDS Field Description...........................................................................5-8


5-4. EOSView File Save Field Description .............................................................................5-18


5-5. Min/Max Values Window Field Description....................................................................5-19


5-6. Lat/Lon Symbol Window Field Description.....................................................................5-24


5-7. X-Y Cursor Window Field Description............................................................................5-25


5-8. Start/Stride/Edge Pop-up Field Description......................................................................5-36


ix 445-TP-006-002 



This page intentionally left blank. 

x 445-TP-006-002 



1. Introduction 

1.1 Identification 

The EOSView User’s Guide for the ECS Project was prepared under the Earth Observing System 
Data and Information System (EOSDIS) Core System (ECS), Contract (NAS5-60000). 

1.2 Scope 

This document is intended for use by anyone who wished to verify or inspect EOS data products 
written as HDF-EOS or as HDF files. Users of this document will include EOS instrument team 
science software developers and data product designers, DAAC personnel, and end users of EOS 
data products, i.e. scientists and researchers. 

1.3 Purpose and Objectives 

This document will serve as a user’s guide for the EOSView data verification tool, developed for 
ECS. The reader should have an understanding of the user interface and the functionality 
provided with the tool. A cursory understanding of HDF and HDF-EOS data structures is 
recommended, but not required. 

Information on HDF-EOS can be found in The HDF-EOS Users Guide for the ECS Project. 
Information on HDF can be found in The NCSA HDF User’s Guide. 

1.4 Status and Schedule 

January, 1995, EOSView Design Document Available


Evaluation Plan 6, Version 1.5.1, November, 1995


June, 1996, EOSView, Beta Version 1.9 Available, including:


- Help text enabled on major displays.


- View contents of multiple files simultaneously.


- Display multi-dimensional SDSs in table format.


- Display multi-file SDS group as single entity.


- Text display of annotations.


- Display Attributes on SDSs, Classes on Vgroups/Vdatas.


- Display Vdatas in table format.


- Some scripting commands.
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- Select alternate color palette. 

- Display Data Dictionary, Text in scrolling window. 

- Display Metadata in scrolling window 

November, 1996 – EOSView, Beta Version 2.1 Available, including: 

- Text display of annotations. 

- Display Vdatas in table format. 

- 24-bit raster display. 

- Pan image with outline on thumbnail image. 

- Zoom in image with outline on thumbnail, using pixel replication or interpolation. 

- Zoom out image with outline on thumbnail using subsampling 

- Display color scatter plot (point only). 

- Basic Overlay 

- Swath, Point, Grid interface. 

- Already met:  Improved animation interface. 

- Already met: Select alternate color palettes. 

May, 1997 – Release B.0 Version of EOSView Available, including: 

- Select cursor position Lat/Long, Pixel, Scanline (Grid only). 

- Display cursor position by Lat/Long (Grid only), Pixel (all images), Scanline (Swath 
only). 

- Save HDF and HDF-EOS objects to ASCII or binary file. 

July 1997 – EOSView, Beta Version 2.5 Available 

August 1998 – EOSView 3.0 Available including: 

- Plot range options. 

December 1999 – EOSView 3.1 Available including: 

- Lat/Long lines for polar Grid images. 

- Ability to save data from list box to ASCII file 

1.5 Document Organization 

This document is organized as follows: 

Section 1 Introduction - Presents Scope and Purpose of this document 

Section 2 Related Documentation 
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Section 3 Overview of EOSView - Background and design features of the tool 

Section 4	 Installation and Maintenance - Information on obtaining the tool, supported 
platforms, user help 

Section 5 EOSView User Interface 
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2. Related Documentation 

2.1 Parent Documents 

The following document is the parent from which this document’s scope and content derive: 

423-41-03	 Goddard Space Flight Center, EOSDIS Core System Contract Data 
Requirements Document, Data Item Description No. 311 

423-41-03	 Goddard Space Flight Center, EOSDIS Core System Contract Data 
Requirements Document, Data Item Description No. 609 

2.2 Related Documents 

The following documents are directly applicable to this requirement’s specification: 

333-CD-003 SDP Toolkit Users Guide for the ECS Project 

170-TP-500	 Release 5A HDF-EOS Library Users Guide for the ECS Project – 
Volume 1: Overview and Examples 

170-TP-501	 Release 5A HDF-EOS Library Users Guide for the ECS Project – 
Volume 2: Function Reference Guide 

none University of Illinois, Getting Started with HDF 

none University of Illinois, NCSA HDF User’s Guide 

none University of Illinois, NCSA HDF Reference Manual 

none	 University of Illinois, NCSA HDF Specification and Developer’s 
Guide 
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3. Overview of HDF and HDF-EOS 

3.1 Introduction 

Prior to discussing EOSView, it is helpful to provide an overview of the data formats which the 
tool is designed: namely HDF. 

The Hierarchical Data Format (HDF) has been selected by the Earth Observing System (EOS) 
Data and Information System, Core System (ECS) Project as the format for EOS standard 
product distribution. HDF is a general scientific data format, which supports raster, text, array 
and table type structures. The files are self-describing and portable to most Unix systems. HDF 
data structures are implemented with a software interface supplied by the National Center for 
Supercomputing Applications (NCSA). See NCSA HDF User’s Guide and references. HDF has 
been extended by the ECS Project to focus conventions for writing EOS data products. These 
extensions, called HDF-EOS, are described below. 

EOSView has been designed to supply the user with the capability of opening and inspecting the 
contents of an HDF-EOS or HDF data file. The tool will provide producers and users of EOS 
data the ability to navigate through HDF-EOS and HDF files, display metadata, file directory 
information, and data in table and/or image form. 

3.2 HDF and HDF-EOS File Formats 

3.2.1 Overview 

Most of the NCSA defined datatypes map well to EOS datatypes. Examples include raster 
images, multi-dimensional arrays, and text blocks. There are other EOS datatypes, however, that 
do not map directly to NCSA datatypes, particularly in the case of geolocated datatypes. 
Examples include projected grids, satellite swaths, and field campaign or point data. 

An HDF file consists of a directory, and records pointed to by that directory. Each directory 
entry conists of fields for the record type (TAG), a unique ID number (REF), and a location and 
size of the record pointed to. All locations in the HDF file are in byte locations from the 
beginning of the file. All record sizes are also specified in bytes. 

Supported record types include images, multidimensional arrays, text, tables (known in HDF as 
Vdatas), and so on. One record type, known as Vgroup, lets the user group a series of records 
into a larger structure, similar to disk directories. 

To bridge the gap between the needs of EOS data products and the capabilities of HDF, the ECS 
Project has developed extensions of HDF, which standardize the conventions for writing HDF 
files, and are called HDF-EOS. Theses extensions facillitate the creation of Grid, Point, and 
Swath data structures. The software interface for the HDF-EOS implementation is very similar 
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to the HDF interface. See HDF-EOS Users Guide for the ECS Project [170-TP-001-001] and 
references. 

The Point interface is designed to support data that has associated geolocations information, but 
is not organized in any well defined spatial or temporal way. The Swath interface is tailored to 
support time-ordered data such as satellite swaths (which consist of a time-ordered series of 
scanlines), or profilers (which consist of a time-ordered series of profiles). The Grid interface is 
designed to support data that has been stored in a rectilinear array based on a well defined and 
explicitly supported projection. 

3.2.2 Structure of an HDF-EOS File 

An HDF-EOS file is any valid HDF file (i.e. any file created by the NCSA HDF library), that 
contains a family of global attributes called “coremetada.X”, where “.X” is a sequence number 
beginning at 0 and running as high as 9. Optional data objects which may appear in an HDF-
EOS file include, another family of global attributes called “archivemetadata.X” and any number 
of Point, Swath, and/or Grid data structures. The existence of Point, Swath, or Grid structures in 
an HDF-EOS file implies the existene of another family of global attributes called 
“StructMetadata.X”. These terms are defined below. 

Core Metadata 

Core Metadata represent information which will be used to populate searchable tables within the 
structure. These metadata, which are defined in DID 311, are contained in the “coremetadata.X” 
(X=0,...,n) family of global attributes within an HDF-EOS file. The syntax of these metadata is 
compliant with the Object Description Language (ODL). Tools for formatting, accessing and 
writing core metadata are provided in the ECS Science Data Processing (SDP) Toolkit. 

Archive Metadata 

Archive metadata represent information that, by definition, will not be searchable. It contains 
whatever information the file creator considers userful to be in the file, but which will not be 
directly accessible for the system. These metadata are also accessed via SDP Toolkit calls and 
are written in ODL syntax into the “archivemetadata.X”, (X=0,...,n) family of global attributes. 

Structural Metadata 

Structural metadata describe the contents and structure of an HDF-EOS file. These metadata are 
present in the file only if the HDF-EOS library has been invoked to create a Grid, Point, or Swath 
structure. These metadata are stored in the “StructMetadata.X” family of global attributes and 
are created and maintained by the HDF-EOS library. These metadata are not intended to be 
directly accessed by data producers or users. Therefore, all access to these metadata should be 
via appropriate function calls in the HDF-EOS library. 

Point Structure 

Point structures are implemented in HDF-EOS files as a hierarchy of Vgroups containing several 
Vdatas, i.e. tables. All Vgroups and Vdatas that are part of any Point structure carry the class 
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“POINT”. Each level of data within a Point structure is implemented as a single Vdata, with 
each data field being named field in the Vdata. 

The following limitations apply to Point structures and should be kept in mind by EOSView 
users: 

•	 The reserved field names for special purpose geolocation fields are “Longitude”, 
“Latitude”, “Colatitude”, and “Time” (case sensitive). These fields are subject to the 
following requirements: 

Field Name Data Type Format 

Longitude float32 or float64 Decimal degrees on the range [-180.0, 180.0] 

Latitude float32 or float64 Decimal degrees on the range [-90.0, 90.0] 

Colatitude float32 or float64 Decimal degrees on the range [0.0, 180.0] 

Time float64 TAI93 (seconds until(-)/since(+) midnight 1/1/93) 

• Fields may only be one-dimensional. 

• Up to 8 levels may exist in a Point structure. 

Swath Structure 

Swath structures are implemented as a hierarchy of Vgroups containing a number of Vdatas 
and/or SDSs, i.e. tables and multi-dimensional arrays. All Vgroups and Vdatas that are part of 
any Swath structure carry the class “SWATH”. Each one-dimensional field is implemented as a 
named field within its own Vdata.  One-dimensional fields that are the same length, are merged 
into “communal” Vdatas, with each data field occupying one field in the Vdata. 

Each multi-dimensional field is implemented as an SDS. Three dimensional fields which share 
the same dimensionality, dimension sizes, and data type and which are specifically allowed by 
the calling program are merged into communal SDSs with three dimensions. Two-dimensional 
arrays are merged as if they were three-dimensional arrays with a first dimension of size 1. No 
merging is performed on fields with more than three dimensions, on fields with an unlimited 
dimension, or on compressed fields. 

The following limitations apply to Swath structures: 

•	 The reserved field names for special purpose geolocation fields are “Longitude”, “Latitude”, 
“Colatitude”, and “Time” (case sensitive). These fields are subject to the following 
requirements: 
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Field Name Data Type Format 

Longitude float32 or float64 Decimal degrees on the range [-180.0, 180.0] 

Latitude float32 or float64 Decimal degrees on the range [-90.0, 90.0] 

Colatitude float32 or float64 Decimal degrees on the range [0.0, 180.0] 

Time float64 TAI93 (seconds until(-)/since(+) midnight 1/1/93) 

These fields may be one- or two-dimensional 

• Non-reserved fields may have up to 8 dimensions. 

• An “unlimited” dimension must be the first dimension (in C-order). 

•	 For all multi-dimensional fields in scan- or profile-oriented Swaths, the dimension 
representing the “along track” dimension must precede the dimension representing scan 
or profile dimension(s). 

•	 Compression is selectable at the field level within a Swath. All HDF-supported 
compression methods are available through the HDF-EOS library. Specifying 
compression on a field prevents merging. 

Note: EOSView users need not be concerned whether a file has been compressed internally or 
not. The tool will uncompress the file automatically. 

Grid Structure 

Grid structures are implemented as a hierarchy of Vgroups containing several SDSs. All 
Vgroups that are part of any Grid structure carry the class “GRID”. Each data field within a Grid 
structure is implemented as a single SDS. Merging is done the same way for Grid data fields as 
for multi-dimensional Swath data fields. 

The following limitations apply to Grid structures: 

• Fields may have from 2 to 8 dimensions. 

•	 Compression is selectable at the field level within a Grid. All HDF-supported 
compression methods are available through the HDF-EOS library. Specifying 
compression on a field prevents merging. 

Note: EOSView users need not be concerned whether a file has been compressed internally or 
not. The tool will uncompress the file automatically. 
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4. Environment, Installation and Maintenance 

4.1 Introduction 

EOSView is designed to be a stand-alone tool for accessing HDF and HDF-EOS files. The 
installation instructions are described below. 

4.2 Download Instructions 

Downloading EOSView can be accomplished by using an ftp session. The address is:


ftp edhs1.gsfc.nasa.gov


Name: anonymous


Password: <your e-mail address>


ftp>quote site group sdptk


ftp> quote site gpass ecs-tkit


ftp>cd eosview


A README file will also be provided in this directory.


ftp>get README


This file will answer many questions you have about running EOSView.


Change to the eosview directory that matches your hardware.


dec/


hp/


ibm/


sgi/


sun/


source/


Once in the directory set type to I, download the files, and exit.


ftp>bin


ftp>mget *


ftp>bye


The following files will be downloaded:
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EOSView (executable) 

eosview.csc (hypertext on-line help file) 

eosview.uid (user interface description file) 

eosview.dat (IDL commands file) 

If the user prefers to view the EOSView source code, change to the source/ directory and 
download the file EOSVIEW_source.tar.Z. This is a compressed tar file. To unload the contents 
of this file type: 

uncompress EOSVIEW_source.tar.Z 

tar xvf EOSVIEW_source.tar 

Start EOSView by typing ‘EOSView’ at the command prompt. If the environment variables 
described in Section 4.3.4 are not set, the current working directory must contain the four 
EOSView files. 

4.3 Notes 

4.3.1 Approved Platforms 

EOSView was built and tested in a multi-platform environment. The list of approved platforms, 
which includes information about operating system is given in Table 4-1. The platforms should 
run Motif 1.2 window manager. 

Table 4-1. Operating Systems 
Platform OS Version 

Sun Sparc Solaris 2.5.1 

HP 9000/735 HP-UX 10.20 

SGI IRIX 6.2 

DEC Alpha OSF1 4.0 

IBM AIX 4.3 

4.3.2 Interfaces and Data Types 

EOSView exchanges data of various types through internal interfaces within ECS: 

• IDL for graphics 

• XVT for GUI builder 

• links with the HDF compile time library 
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4.3.3 Tunable Parameters 

The following attributes can be modified through the standard .Xdefaults file: 

• focus policy (mouse pointer) 

• icon geometry (size and location) 

• fonts 

• colors 

4.3.4 Environment Variables 

Table 4-2 lists the environment variables for EOSView. These variables are optional. 

Table 4-2. Environment Variables 
Required By Environment Variable Description or Valid Ranges 

EOSView UIDPATH location of the eosview.uid ontains a 
description of GUI objects 

EOSView EOSVIEWHELPDIR location of eosview.csc (hypertext on-line help 
file) and eosview.dat file (idl commands) 

EOSView ECS_HOME directory for File Selection dialog to begin 

file that c

4.3.5 Special Constraints 

EOSView will read only HDF and HDF-EOS formatted files. 

4.3.6 Command Line Interface 

Command line interface is available through a script file as a separately created text file passed 
as a command-line argument for EOSView to read and perform actions. The following script 
commands are valid: 

• OPEN [filename] - opens file ‘filename’ 

•	 DISPLAY IMAGE [n] - displays the n-th image in the file (must be preceded by OPEN 
command) 

•	 ANIMATE IMAGES 999 - animates all images in file (must be preceded by OPEN 
command) 

4.4 User Feedback Mechanism 

The mechanism for handling user feedback, documentation and software discrepancies, and bug 
reports follows: 

1)	 The following account at the ECS Landover facility has been set up for user response: 
pgstlkit@eos.hitc.com 
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2)	 Users will e-mail problem reports and comments to the above account. A receipt will be 
returned to the sender. Responses will be prioritized based on the severity of the problem 
and the available resources. Simple bug fixes will be turned around sooner, while 
requested functional enhancements will be placed in a recommended requirements data 
base (RRDB) and handled more formally. 

3)	 In order to help expedite responses, we request the following information be supplied 
with problem reports: 

Name: 

Date: 

EOS Affiliation (DAAC, Instrument, Earth Science Data and Information System (ESDIS), etc.): 

Phone No: 

Computing Platform: 

Operating System (including version): 

Problem Description: 
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5. EOSView User Interface 

5.1 Introduction 

EOSView is a custom HDF file verification tool. It displays the contents of HDF files and the 
contents of files containing HDF-EOS data. Individual objects can be selected for display. 
Displays include Raster images, datasets in tables, pseudo-color images of datasets, attributes, 
and annotations. Simple animation can be performed for a file with multiple raster images. 

EOSView has a unique interface for handling HDF-EOS data structures. The Swath/Grid/Point 
interface uses only HDF-EOS library calls. The EOSView operator will not see the underlying 
HDF structures but will be prompted for which parts of the structure they wish to view. 

EOSView is used to perform the operator functions listed in Table 5-1. 

Table 5-1. Common ECS Operator Functions Performed with EOSView 
(1 of 2) 

Operating 
Function 

Command/Script 
or GUI 

Description When and Why to Use 

Display HDF file 
contents 

EOSView File 
Contents window 

Looks at data file images, 
metadata, and auxiliary 
information 

To verify structures put in 
a file 

Display Raster 
Image 

Image Display window • displays Browse 
images, geolocated 
maps, etc 

• multiple zoom features 
in image display 
available 

• pan feature available 
• multiple palettes 

available 

To view a snapshot of an 
image (not data) 

Animate Raster 
Images 

Animation Window presents in order images 
as they appear in each 
file 

To show a succession of 
movement (e.g., 
temperature adjustment 
from one image to the 
next) 

Display of SDS 
data in table 

• SDS data table 
• Vdata table 

Displays a one or two 
dimensional list of data in 
a scrollable list 

To view/compare 
associated numbers 

Expand a Vgroup Select “Vgroup” from 
File Contents window 

Vgroups are logical 
groupings of information 
such as Vdata, SDS data, 
and images 

To view information by a 
certain subject (e.g., the 
information associated 
with Geolocation) 
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Table 5-1. Common ECS Operator Functions Performed with EOSView 
(2 of 2) 

Operating 
Function 

Command/Script 
or GUI 

Description When and Why to Use 

Pseudo-color 
display of SDS 
data 

Image Display Window Converts data into a 
visual image 

To view the pseudo-color 
image of an SDS table 

Display text 
objects 

Text (Attributes) 
Window 

Describes the types of 
data strings for an 
individual object or for an 
entire file 

To look at factors when 
doing computations 
(e.g., longitude/latitude) 

Hypertext help On-line Help On-line help is available 
from all menu bars 

to help in the navigation 
and use of EOSView 

Swath/Point/Grid 
interface (HDF-
EOS) 

File Contents Display 
window for swath, 
point and grid files 

View HDF-EOS objects at 
a high level (i.e., data 
types cannot be broken 
down) 

To view segments of 
data in terms of swath, a 
point on the earth, and 
grid (e.g., lat/long) data 

Plot VData EOSView Plot Window Static line plot display of x 
and y data (from a Vdata 
Table) 

To view line plot of data 
capabilities 

Plot SDS Data EOSview 
surface/contour plot 
window 

Surface or contour plot of 
SDS 

To view plots of SDS 
tables 

5.2 Quick Start Using EOSView and GUI Overview 

This section presents an orientation of EOSView. 

5.2.1 Invoke EOSView 

EOSview can be started from the UNIX command line by typing the command: 

EOSView 

5.2.2 EOSView Main Screen 

The EOSView Main Window (shown in Figure 5-1) displays the current version of EOSView 
and date. 
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Figure 5-1. EOSView Main Screen 

From the File pulldown menu, the operator can select Open or Exit. 

• Open -- This will cause a file selection dialog to appear (shown in Figure 5-2) 

• Exit – Exits EOSView 

From the Window pulldown menu, the operator can select an EOSView screen and have the 
focus change to that window as long as it is currently open. This feature is described in 
Section 5.2.23 “Window Pulldown Menu.” 

From the Help pulldown menu, the operator can select help on context, on help, on window, 
keys, contents, index and version. This feature is described in Section 5.2.25 “Help Pulldown 
Menu.” 
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5.2.3 EOSView File Selection Dialog 

Selecting Open from the EOSView File pulldown menu will bring up the File Selection Dialog 
shown in Figure 5-2. This is a standard file selection dialog box that lets the operator search 
through directories and select an HDF file. 

Figure 5-2. File Selection Dialog 

Table 5-2 describes the File Selection fields. 

Table 5-2. EOSView File Selection Field Description 
Field Name Data Type Size Entry Description 

Filter system generated 
(editable) 

unlimited required displays file selection parameters to 
filter the directories 

Directories selection unlimited required displays a list of directories 

Files selection unlimited required displays a list of files to select from 

Select Input File system generated 
(editable) 

unlimited required displays the filename selection 
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In addition, the following pushbuttons are provided: 

• OK –  opens the specified file 

•• Filter –  filters through the directories in layers until the desired directory/file is 
displayed 

• Cancel – closes the file selection dialog 

5.2.4 File Contents Display Pop-up 

Once the HDF file has been selected, the File Contents Pop-up (see Figure 5-3) for that file will 
appear. This is a scrollable window with the following menu items: 

•• The File pulldown menu (described in Section 5.2.21) provides additional information 
about a file and provides a way to close the file. 

•• The Options pulldown menu (described in Section 5.2.22) and its Animate images 
selection becomes sensitized when the selected file contains multiple Raster Image 
Groups. This will cause all the images to be lined up and displayed in order in an 
EOSView - Animation Window. 

•• From the Window pulldown menu, the operator can select an EOSView window and 
have the focus change to that window as long as it is currently open. This feature is 
described in Section 5.2.23 “Window Pulldown Menu.” 

•• From the Attributes pulldown menu (described in Section 5.2.24), the operator can view 
the global attributes for the selected HDF file. 

•• From the Help pulldown menu (described in Section 5.2.25), the operator can select help 
on context, on help, on window, keys, contents, index and version. 

To select an HDF object simply double-click on the object that is displayed in the scrollable 
window. Objects can be Numeric Data, Vdata, Vgroup, Raster Images, or Grid/Swath/Point data. 
Each of these objects are described in the following sections. 

5.2.5 Numeric Data Group 

In this example, the GEO.granule.terr HDF file was selected from the File Selection Dialog, 
bringing up the File Contents Display Pop-up shown in Figure 5-3. 
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Figure 5-3. EOSView File Contents Pop-up 

Double-clicking on an item from the EOSView File Contents Pop-up (in this example, Numeric 
Data Group: “sol_azimuth” Size : [1000X1354] was selected) brings up the Multi-Dimension 
SDS window as shown in Figure 5-4. This window allows the operator to select dimensions and 
indices for other dimensions. 
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Figure 5-4. Multi-Dimension SDS Pop-up 

Table 5-3 describes the fields of the Multi-Dimension SDS Pop-up. 
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Table 5-3. Multi Dimension SDS Field Description�
Field Name Data Type Size Entry Description 

Index integer N/A Required Index of involved dimensions. 
For the selected dimension the 
default value is 0. For the 
unselected dimension the 
number can be as large as what 
is in bracket after dimension 
name. 

EOSView can only display 2 dimensional datasets. If a dataset contains more than 2 dimensions, 
a 2-D slice of the dataset needs to be selected. This is accomplished by selecting ONLY 2 
dimension boxes to the left of the dimension name. The other dimensions can have an index 
entered in the text box. Additional information for each dimension can be displayed in a separate 
window by pressing the button next to the dimension the information is desired. Clicking on the 
Info button will bring up a Dimension Information pop-up shown below in Figure 5-5. 

Figure 5-5. Dimension Information Pop-up 

This window contains information such as number of attributes, units, format, size, etc. From this 
window, the operator can display textual output of the attributes for this dimension by clicking 
on the Attrs… button. Selecting Close closes the EOSView - Dimension Information Window. 
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Selecting the Table button from the Multi-Dimension SDS window brings up a table window as 
shown in Figure 5-6. The table window will display a 1 or 2 dimensional list of the data as either 
a Scientific Data Group or Vdata. The window is sizable and contains horizontal and vertical 
scrollbars. 

The File pulldown menu contains the following items, as shown in figure 5-6: 

•	 Make Image - This will create a pseudo-color image of the selected table. Selecting this 
option causes the Min/Max Values Pop-up to appear (figure 5-14). 

•	 Plot - if the table has been created from an SDS the operator has the option of converting 
the table to a surface or contour plot as shown in figure 5-7. 

•	 Attributes - This displays text attributes assigned to this table.  Selecting this option will 
cause the Attributes Text Display Pop-up to appear as shown in figure 5-34. 

•	 Statistics - EOSView has basic statistical capabilities for table data. An SDS table will 
have the minimum, maximum and average for the entire table displayed in the EOSView 
- Stats window (see figure 5-11). For a table created from Vdata data the same stats will 
be calculated for each column of data (field of Vdata). The EOSView stats window 
displays the name, min, max, and average values of a table. The name corresponds to the 
name of the SDS or Vdata field name. The data is not editable and non-selectable. Hitting 
the “Ok” button will close the EOSView Stats Window. 

•	 Jump To – This option allows the operater to jump to a specific row in a table.  Selecting 
this option causes the Jump To Dialog to appear (figure 5-12). The user may enter the 
desired row number. Once the OK button is pressed the desired row number will appear 
in the first row of the table. See section 5.2.7 for a description of the Jump To… option. 

•	 Save - This option allows the operator to save the table in either ASCII or binary format. 
Once the operator has selected ASCII or binary from the cascading menu the EOSView 
File Save Dialog is displayed (see figure 5-13). This window is similar to the EOSView 
File Open Dialog. EOSView will only save tables to a new file, therefore, a unique file 
name must be entered in the “Save as:” text field. 

• Close Window - Closes the table window. 
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Figure 5-6. EOSView “sol_azimuth” Table Pop-up 
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Figure 5-7. EOSView Contour Plot Pop-up 

5.2.6 Surface/Contour Plot 

The EOSView Contour/Surface Display will display a surface or contour plot of the selected 
Numeric Data Group. The window contains a menubar and can be resized. 

•	 The File menubar option contains only one option. Selecting Close will close the 
surface/contour plot window. 

•	 The Plot Type menubar options acts as a toggle between the surface and contour plots. If 
the current plot being displayed is a contour plot then the option listed will be Surface 
Plot. If the current plot being displayed is a surface plot then the option listed will be 
Contour Plot. Selecting this option will cause a new window to appear with the selected 
plot. 
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•	 The Modify Plot Data menubar option allows the user to modify the plots based on three 
criteria. The user may modify a plot by excluding a range of data, excluding up to three 
individual values, or plotting between a minimum and maximum value. 

•	 The Window option lists in a pull-down menu all windows which are currently open See 
Section 5.2.23 “Window Pulldown Menu.” 

Figure 5-8. Contour/Surface Data Range Pop-up 

The option Data Range to Exclude listed under the Modify Plot Data menubar option will 
cause the Contour/Surface Data Range window to appear (figure 5-8). The user can select a 
range of data to exclude from the plot by entering the minimum value to exclude in the Minimum 
Value text field and the maximum value to exclude in the Maximum Value text field. The user 
can select the number of contour levels desired by entering the number in the Contour Levels text 
field. Entering data in the Contour Levels text field is optional. The Contour Levels text fields 
will only appear in the Data Range Pop-up if the plot was a contour plot. Pressing the Continue 
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button will cause a new plot to be drawn without the data range entered. Pressing the Cancel 
button closes the window with no further action. 

Figure 5-9. Contour/Surface Data Value Pop-up 

The option Data Value listed under the Modify Plot Data menubar option will cause the 
Contour/Surface Data Value window to appear (figure 5-9). The user can enter up to three values 
that will not be plotted. The first value should be entered in the Data Value 1 text field, the 
second value should be entered in the Data Value 2 text field, and the third value should be 
entered in the Data Value 3 text field. The user can select the number of contour levels desired 
by entering the number in the Contour Levels text field. Entering data in the Contour Levels text 
field is optional. The Contour Levels text fields will only appear in the Data Range Pop-up if the 
plot was a contour plot. Pressing the Continue button will cause a new plot to be drawn without 
the selected data values. Pressing the Cancel button closes the window with no further action. 
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Figure 5-10. Contour/Surface Min/Max Range Pop-up 

The option Min - Max Range listed under the Modify Plot Data menubar option will cause the 
Contour/Surface Min/Max Range window to appear (figure 5-10). The user can enter a range of 
values that is desired to be plotted. All values less than the minimum value and greater than the 
maximum value will not be plotted. The minimum value to be plotted may be entered in the 
Minimum Value text field. The maximum value to be plotted may be entered in the Maximum 
Value text field. The user can select the number of contour levels desired by entering the number 
in the Contour Levels text field. Entering data in the Contour Levels text field is optional. The 
Contour Levels text fields will only appear in the Data Range Pop-up if the plot was a contour 
plot. Pressing the Continue button will cause a new plot to be drawn using the data range 
entered. Pressing the Cancel button closes the window with no further action. 
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Figure 5-11. EOSView Stats Pop-up 

The EOSView Statistics Pop-up window will list the minimum value, maximum value and 
average value in a table. For a table created from an SDS the values will be taken from the entire 
table. For a table from a Vdata the values will be from each column. No statistics will be 
calculated for character data. To close this window press the OK button. 
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Figure 5-12. Jump To Dialog 

5.2.7 Jump To Dialog 

The user may jump to a specific row number in a table by seleecting the Jump To… option. 
Selecting this option will cause the Jump To Dialog (Figure 5-12) to appear. This dialog will 
accept integer input in the range listed in the text field preceded with “Enter row number…” 
Pressing the “OK” button will cause the table to jump to the selected row number. Pressing the 
“Cancel” button will close the Jump To Dialog with no action being taken on the table. 
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Figure 5-13. File Save Dialog 

5.2.8 File Save Dialog 

The user may save a table in EOSView in one of two ways. The table may be saved in either an 
ASCII format or it may be saved as a binary file. Selecting the save option will cause the File 
Save Dialog to appear. The user may then enter the name of the file that is desired to save the 
table into. EOSView will only save the table to a new file. The EOSView table save mechanism 
saves to the HDF ASCII Interchange Format (HAIF). 
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Table 5-4 describes the File Save fields. 

Table 5-4. EOSView File Save Field Description�
Field Name Data Type Size Entry Description 

Filter system generated 
(editable) 

unlimited required displays file selection parameters to 
filter the directories 

Directories selection unlimited required displays a list of directories 

Files selection unlimited required displays a list of files 

Save As system generated 
(editable) 

unlimited required displays the filename selection - user 
may enter to new filename in this 
field 

In addition, the following pushbuttons are provided: 

• OK –  saves to the specified file 

• Filter –  filters through the directories in layers until the desired directory is displayed 

• Cancel – closes the file save dialog 

5.2.9 Make Image From Table Data 

A pseudo-color image can be built from the data displayed in the Table. The image can be 
created by selecting File - Make Image from the menu bar of the EOSView - Table Pop-up. 
Selecting this option causes the Min/Max Values window to appear as shown in Figure 5-14. 
Table 5-5 describes the fields of the Min/Max Values Pop-up. 

Figure 5-14. Min/Max Values Pop-up�
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Table 5-5. Min/Max Values Window Field Description�
Field Name Data Type Size Entry Description 

Minimum Value integer or float 
(depending upon 
original data 
values) 

N/A required Min value used for the image 
(field size is limited by the values 
that first appear when the window 
opens) 

Maximum Value Integer or float 
(depending upon 
original data 
values) 

N/A required Max value used for the image 
(field size is limited by the values 
that first appear when the window 
opens) 

From the Min/Max Values Window, the operator has the opportunity to enter the minimum and 
maximum values used for the image. Pressing the Continue button will cause the EOSView -
Image Display Pop-up to appear (shown in Figure 5-15). The operator may cancel all actions by 
pressing the Cancel button. 
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Figure 5-15. “sol_azimuth” Image Display Pop-up 

5.2.10 Image Display 

The Image Display pop-up has the following pulldown menu options: File, Palette, Zooming, 
Cursor, Window, and Help. 
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•
 Inside the File, the Overlay option is active only if the image has been created from a grid 
table. The Overlay option allows the operator to have lat/lon lines drawn over the image 
or the operator may have an icon displayed at a point on the grid image. See section 
5.2.11 which describes the EOSView lat/lon window for symbols and cursor positioning. 
Selecting the Close option exits the Image Display Window. 

•
 The Palette pulldown menu allows the operator to select colors from the following types 
of palettes for comparison: Default, Greyscale, Antarctica, Rainbow, and World Colors. 
The first palette option is "Default" which is the palette provided within the HDF file of 
the image being displayed; if no palette was provided, the default color map is used The 
second palette option is "Grayscale" which will be a black and white version of the image 
being displayed. The next three options are "Antarctica", "Rainbow" and "World Colors." 
These three palettes are provided as part of EOSView. Selecting one of these three 
palettes will cause the current image to use that palette. The “Use Entire Palette” option is 
not functional. 

•
 The Zooming pulldown menu allows the operator to select from two zoom methods: 
Bilinear Interpolation and Nearest Neighbor. Bilinear Interpolation uses interpolation to 
calculate the probable color during an expansion/compression event; it gives a much 
smoother image during zooming. The second is Nearest Neighbor which uses sub­
sampling or super sampling to determine probable color, e.g., two red pixels are now four 
red pixels during expansion. 

•
 The Cursor pulldown menu allows the operator to set the cursor at a specified position. 
The first is “X-Y Position” . The Operator will be prompted for an X-Y location and the 
cursor will be positioned at that location. In EOSView, position 0,0 is the lower left 
corner (see section 5.2.12, which describes the EOSView - x-y cursor window). If the 
image has been created from a grid table, the operator may enter a lat/lon position and the 
cursor will be positioned to that location. See section 5.2.11 which describes the 
“EOSView - lat/lon window (used for symbols and cursor positioning). If the image has 
been created from a swath table the operator may position the cursor at the selected scan 
line. The cursor will be placed at the beginning of the scanline. See section 5.2.13 which 
describes the EOSView Scanline Cursor Window. 

•
 The Window option lists in a pull-down menu all windows which are currently open. See 
Section 5.2.23 “Window Pulldown Menu.” 

• Help – see Section 5.2.25 “Help Pulldown Menu.” 

The Image Display also has the following pushbuttons: Zoom In and Zoom Out. It also has a 
panning feature as described below. 

•
 Zoom In and Zoom Out pushbuttons -- pressing the Zoom In button will cause the 
image to be zoomed in and re-drawn in the image window. Pressing the Zoom Out button 
will cause the image to be zoomed out until it returns to original size. The zoom factor 
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will be displayed in the bottom left corner of the EOSView - Image Display Window on 
the status bar. 

•
 Pan Window -- If the operator has zoomed in on an image, the operator may pan around 
the image by holding down the left mouse button while the cursor is in the postage stamp 
size image and moving it around. The cursor will be outlined by a box which indicates 
the portion of the image being displayed in the full size image window. 

The Image Display Pop-up also has cursor tracking capabilities. Placing the cursor on the image 
and holding the left mouse button will cause the cursor position (in x-y coordinates) to be 
displayed on the right side of the status bar. If the image has been created from a grid table the 
cursor position will be displayed in lat/lon coordinates on the right side of the status bar. 

5.2.11 Lat/Lon Symbol Pop-up 

The EOSView Lat/Lon Symbol/Cursor pop-up (figure 5-16) allows the operator to enter the 
desired coordinate pair in one of two ways. Degrees-minutes-seconds (DMS radio button) allows 
the operator to type in the degrees (Deg), minutes (Min), and seconds (Sec) for the latitude and 
the longitude. The second method is by entering degrees (DEG radio button) in the degrees text 
fields. In either case the operator may switch between North (N), South (S), and East(E), West 
(W) by using the list buttons to the right of the text entry fields. For both entry methods, hitting 
the “Ok” button will cause the cursor to be positioned or a symbol drawn at the desired location. 
Hitting the “Cancel” button will cancel the operation. 
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Figure 5-16. Lat/Lon Symbol Pop-up 
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Table 5-6 describes the parameters in the Lat/Lon Symbol Window. 

Table 5-6. Lat/Lon Symbol Window Field Description 
Field Name Data Type Size Entry Description 

Lat (DMS) float N/A required Latitude (if DEG is selected) 

Lon (DMS float N/A required Longitude (if DEG is selected) 

Lat/Lon (Deg) float N/A required Degrees of Latitude/Longitude (if 
DMS is selected) 

Lat/Lon(Min) float N/A required Minutes of Latitude/Longitude (if 
DMS is selected) 

Lat/Lon(Sec) float N/A required Seconds of Latitude/Longitude (if 
DMS is selected) 

5.2.12 X-Y Cursor Window 

The operator may enter the X-Y coordinates to have the cursor positioned by using the EOSView 
X-Y Cursor Pop-up (figure 5-17). The operator may enter the desired X-Y location in the 
corresponding X-Y text field. The X-Y limits are placed to the right of the text fields. Hitting the 
“Ok” button will cause the cursor to be placed at the desired location in the image. Hitting the 
“Cancel” button will cancel the operation. 

Figure 5-17. X-Y Cursor Pop-up 
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Table 5-7 describes the parameters in the X-Y Cursor Pop-up. 

Table 5-7. X-Y Cursor Window Field Description 
Field Name Data Type Size Entry Description 

X: integer N/A required X horizontal coordinate (max 
accepted value is listed to the right 
of the text field) 

Y: integer N/A required Y vertical coordinate (max accepted 
value is listed to the right of the text 
field) 

5.2.13 ScanLine Cursor Window 

If the image was created from a Swath table the operator may position the cursor to the 
beginning of the scanline by using the EOSView - ScanLine Cursor Pop-up (figure 5-18). 
Moving the slider left and right will cause the scanline value below the slider to decrease and 
increase, respectively. Once the desired scanline is achieved, hitting the “Ok” button will cause 
the cursor to be placed at the beginning of the scanline. Hitting the “Cancel” button will cancel 
the operation. 

Figure 5-18. Scanline Cursor Pop-up 

5.2.14 Vdata 

In this example, the packVdata1.hdf file was selected from the File Selection dialog, bringing up 
the Vdata File Contents Pop-up (see Figure 5-19). 

5-25 445-TP-006-002




Figure 5-19. File Contents Pop-up Containing Vdata 

Double-clicking on the Vdata entry brings up the “EOSView - VData Field Select” pop-up 
(shown in figure 5-20). This window lists all the field names in the selected Vdata. The operator 
may select one or more fields for display. If the fields contain multiple values for a field then 
that field will appear in its own table. 

Figure 5-20. EOSView - Vdata Field Select Pop-up 
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Table button - Once the operator has selected the fields desired, pressing the table button will 
cause the Vdata to appear in a table. 

Figure 5-21. Table containing Vdata field Pop-up 

Plot button - The operator may select one or two non-character data fields and have the data 
plotted by pressing the plot button (see figure 5-22). 

Cancel button - Cancels all actions 
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Figure 5-22. Plot Pop-up 

The Plot Pop-up created from the Vdata Field Select window contains the following menu 
options: 

• The File options allows the user to close the window by selecting Close. 

•	 The Window option lists in a pull-down menu all windows which are currently open. See 
Section 5.2.23 “Window Pulldown Menu.” 
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5.2.15 VGroup 

If the object in the File Contents Display Window is a Vgroup, the contents of the VGroup will 
be added to the list and the list will be re-drawn in the list box. Clicking on a VGroup that has 
already had the contents expanded will cause the contents of the VGroup to disappear and the list 
will be re-drawn in the list box. Figure 5-23 shows several expanded an unexpanded Vgroup 
categories. 

Figure 5-23. File Contents Pop-up containing Vgroups 

5.2.16 Raster Image 

In this example, the alltovs.hdf file was selected from the File Selection dialog, bringing up the 
File Contents Display Window shown in Figure 5-24. 

5-29 445-TP-006-002




Figure 5-24. File Contents Pop-up containing Raster Images 

Clicking on a Raster Image Group will cause the image to be drawn in an EOSView - Image 
Display Pop-up (see Figure 5-25). 
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Figure 5-25. Raster Image Pop-up 

A Raster image is different than the pseudo-color image shown in Section 5.2.9 since this image 
is not drawn from data. It is simply a visual depiction of an object. The menus and pushbuttons 
for this window are the same as those described for the pseudo-color display. See section 5.2.10 
for a description of the Image Display Window. 
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5.2.17 EOSView Grid Select GUI 

In this example, the GridFile.hdf was selected from the File Selection dialog, bringing up the 
GridFile.hdf File Contents Display shown in Figure 5-26. 

Figure 5-26. Grid File Contents Display Pop-up 

Double-clicking on a selection (in this case, the object Vgroup: UTMGrid {GRID} [2] was 
selected) brings up the Grid Select Pop-up shown in Figure 5-27. 

Figure 5-27. Grid Select Pop-up 
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All of the following options are available for selection: Grid Information, Projection Information, 
Dimensions, Data Fields, and Attributes. Selecting OK will bring up windows for all the items 
selected. Clicking on Cancel will return the operator to File Contents Window. Assuming that all 
the items have been selected, the following windows will appear: 

Grid Information Dialog 

To view a summary of a selected Grid object, click on the Grid Information checkbox. The Grid 
Information dialog pop-up (shown in Figure 5-28) displays information about the selected grid 
such as X-Dimension value, Y-Dimension value, Upper Left Point values, and Lower Right 
Point values. 

Figure 5-28. Grid Information Dialog Pop-up 

This window can be closed by pressing the OK button. 
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Projection Information 

To view the Projection Information of the selected Grid object, click on the Projection 
Information checkbox in the EOSView - Grid Select window and press the OK button. This will 
cause the EOSView - Grid Projection Information pop-up shown in Figure 5-29 to appear. 

Figure 5-29. Projection Information Pop-up 
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The Projection Information pop-up displays information about the projection of the selected grid 
in a dialog box. The first item displayed is the Projection itself. If the projection is Universal 
Transverse Mercator, the next item is displayed in the Zone Code. For any other projection the 
next items displayed are the thirteen (13) Projection Parameters. This window can be closed by 
pressing the OK button. 

Dimensions 

To view the dimensions of the selected Grid object, click on the Dimensions checkbox in the 
EOSView - Grid Select pop-up and press the OK button. This will cause the EOSView - Grid 
Dimensions window (shown in Figure 5-30) to appear. 

Figure 5-30. Grid Dimensions Pop-up 

This window lists Dimension Names and Sizes for the selected Grid in table form in a scrollable 
window. The items listed are non-selectable and are for display/verification purposes only. See 
section 5.2.26 for a description of saving the contents of the window to an ASCII file. 

Data Fields 

To view the Data Fields of the selected Grid object simply click on the Data Fields checkbox in 
the EOSView - Grid Select pop-up and press the OK button. This will cause the EOSView -
Grid Data Fields window (shown in Figure 5-30) to appear. See section 5.2.26 for a description 
of saving the contents of the window to an ASCII file. 

Figure 5-31. Grid Data Fields Pop-up 
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To view a slice of the Grid Geolocation/Data Field data, move the pointer over the object and 
double click the left mouse button. This will cause the EOSView - Start/Stride/Edge pop-up 
(shown in Figure 5-32) to appear. 

Figure 5-32. Start/Stride/Edge Pop-up 

Table 5-8 describes the Start/Stride/Edge pop-up fields. 

Table 5-8. Start/Stride/Edge Pop-up Field Description 
Field Name Data Type Size Entry Description 

Start Integer N/A required Start for grid geolocation/data field 
data 

Stride Integer N/A required Stride for grid geolocation/data field 
data 

Edge Integer N/A required Edge for grid geolocation/data field 
data 

This pop-up displays the Start, Stride, and Edge values for each dimension (there may be up to 
eight). The start value for each dimension may be edited but the stride and edge values may only 
be edited for the selected dimensions. This is a way of subsampling the data desired. A 
dimension may be selected by clicking on the check box next to the dimension name. A 
maximum of two dimensions may be selected. Once the operator has entered the desired data the 
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OK button may be pressed and the selected dimension data will be displayed in the EOSView -
Grid Table. For more information on a Table, building a pseudo-color image, and the Min/Max 
Values Pop-up, see Section 5.2.9. The operator may cancel all actions by pressing the Cancel 
button. 

Note that if an input error occurs, a warning dialog (Figure 5-33) will appear, displaying the 
dimension name that is in error and a size total. The operator must meet the criteria in the 
formula displayed in the warning dialog. Click OK to return to the Start/Stride/Edge Window to 
re-enter the correct values. 

Figure 5-33. Warning Dialog 

Attributes 

Clicking on the Attributes checkbox in the EOSView Grid Select Pop-up brings up the Attributes 
Text Display shown in Figure 5-34. 

Figure 5-34. Attributes Text Display Pop-up 
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This display shows the attributes associated with a particular dataset. The text display can be 
closed from the File pulldown menu, the text can be modified using the Font and Style pulldown 
menus, and additional help can be obtained from the Help pulldown menu (see Section 5.2.25 
“Help Pulldown Menu.”) 

5.2.18 EOSView Swath Select 

In this example, the SwathFile.hdf file was selected from the File Selection dialog, bringing up 
the File Contents Pop-up shown in Figure 5-35. 

Figure 5-35. SwathFile File Select Pop-up 

Double clicking on an item in the File Select window brings up the Swath Select Pop-up shown 
in Figure 5-36. 
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Figure 5-36. Swath Selection Pop-up 

As many options as desired can be selected from the following list: Dimensions, Geolocation 
Mappings, Indexed Mappings, Geolocation Fields, Data Fields, and Attributes. Selecting OK 
will bring up windows for all the items selected. Clicking on Cancel will close the Swath 
Selection Pop-up with no action being taken. Assuming that all the items have been selected, the 
following windows will appear. 

Dimensions 

To view the dimensions of the selected Swath object, click on the Dimensions checkbox in the 
EOSView - Swath Select pop-up and press the OK button. This will cause the EOSView - Swath 
Dimensions pop-up to appear. This window lists the Dimension Names and Sizes for the selected 
Swath in a table form in a scrollable window. The items listed are non-selectable and are for 
display/verification purposes only. This window is similar to the Grid file dimensions window 
described in Section 5.2.17 “EOSView Grid Select GUI” (see Dimensions). 
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Geolocation Mappings 

To view the Geolocation Mappings of the selected Swath object, click on the Geolocation 
Mappings checkbox in the EOSView - Swath Select pop-up and press the OK button. This will 
cause the EOSView - Swath Geolocation Mappings window (shown in Figure 5-37) to appear. 

Figure 5-37. Swath Geolocation Mappings Pop-up 

This window lists the Geolocation Dimensions, Data Dimensions, Offsets, and Increments for 
the selected Swath in a table form in a scrollable window. The items listed are non-selectable and 
are for display/verification purposes only. See section 5.2.26 for a description of saving the 
contents of the window to an ASCII file. 

Indexed Mappings 

To view the Indexed Mappings of the selected Swath object, click on the Indexed Mappings 
checkbox in the EOSView - Swath Select pop-up and press the OK button. This will cause the 
EOSView - Swath Indexed Mappings pop-up (shown in Figure 5-38) to appear. 

Figure 5-38. Swath Indexed Mappings Pop-up 

Viewing the size of the mapping may be performed by moving the pointer over the object and 
double clicking the left mouse button. This will cause the EOSView - Indexed Mapping Sizes 
pop-up (shown in Figure 5-39) to appear. See section 5.2.26 for a description of saving the 
contents of the window to an ASCII file. 
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Figure 5-39. Index Mapping Sizes Pop-up 

This window lists the Geolocation Indices and Data Indices for the selected Swath in a table form 
in a scrollable window. The items listed are non-selectable and are for display/verification 
purposes only. The window can be closed by selecting “Close” from the File menu. See section 
5.2.26 for a description of saving the contents of the window to an ASCII file. 

Geolocation Fields 

To view the Geolocation Fields of the selected Swath object, click on the Geolocation Fields 
checkbox in the EOSView - Swath Select pop-up and press the OK button. This will cause the 
EOSView - Swath Geolocation Fields window (shown in Figure 5-40) to appear. 

Figure 5-40. Swath Geolocation Fields Pop-up 
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Selecting a Swath Geolocation to view a slice of the data may be performed by moving the 
pointer over the object and double clicking the left mouse button. This will cause the EOSView -
Start/Stride/Edge pop-up to appear. This window lists the Start, Stride, and Edge values for each 
dimension listed. This window is similar to the Grid file Start/Stride/Edge window described in 
Section 5.2.17 “EOSView Grid Select GUI“ (see Data Fields). See section 5.2.26 for a 
description of saving the contents of the window to an ASCII file. 

Data Fields 

To view the Data Fields of the selected Swath object, click on the Data Fields checkbox in the 
EOSView - Swath Select pop-up and press the OK button. This will cause the EOSView - Swath 
Data Fields pop-up to appear. This window is similar to the Grid file data fields window 
described in Section 5.2.17 “EOSView Grid Select GUI“ (see Data Fields). See section 5.2.26 
for a description of saving the contents of the window to an ASCII file. 

Attributes 

To view the attributes of the selected Swath object, click on the Attributes checkbox in the 
EOSView - Swath Select window and press the OK button. This window is similar to the Grid 
file attributes pop-up described in Section 5.2.17 “EOSView Grid Select GUI “ (see Attributes). 

5.2.19 Point Files 

In this example, selecting PointFile.hdf from the File Select dialog brings up the File Contents 
pop-up shown in Figure 5-41. 

Figure 5-41. PointFile File Contents Pop-up 

Double-clicking on an item in the PointFile pop-up (in this example, the Vgroup: FloatBuoy 
Point {POINT} [4] object is selected) opens the Point Select Pop-up shown in Figure 5-42. 
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Figure 5-42. Point Select Pop-up 

Either Point Data, Attributes or both options can be selected. Clicking on OK will open the 
corresponding windows for the options selected. Clicking on Cancel will close the Point Select 
Pop-up with no action being taken. Assuming both items have been selected, the windows as 
described below will appear. 

Point Data 

To view the Point Data of the selected Point object, simply click on the Point Data checkbox in 
the EOSView - Point Select window and press the OK button. This will cause the EOSView-
Point Level Info pop-up to appear as shown in Figure 5-43. 
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Figure 5-43. Point File Level Information Pop-up 

Double-clicking on any Level Name will bring up the Vdata field select pop-up, shown in figure 
5-20. The operation of the Vdata field select pop-up is described in Section 5.2.14. See section 
5.2.26 for a description of saving the contents of the window to an ASCII file. 

Selecting a field or multiple fields will bring up the table window shown in figure 5-44. 
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Figure 5-44. Vdata Table Pop-up 

The data in this table can be saved by selecting Save from the File pulldown menu (see Section 
5.2.14 for a sample of a Plot Window). The statistics of this table may be viewed by selecting 
Statistics from the File pulldown menu. To close this window select Close from the file 
pulldown menu. 

Attributes 

To view the attributes of the selected Point Select object, click on the Attributes checkbox in the 
EOSView - Point Select window and press the OK button. This window is similar to the Grid file 
attributes pop-up described in Section 5.2.17 “EOSView Grid Select GUI “ (see Attributes). 

5.2.20 Pulldown Menus 

The File Contents Displays all have a common pulldown menu structure with the following 
options: File, Options, Window, Attributes, and Help. These are described in the sections below. 
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5.2.21 File Pulldown Menu 

The File pulldown menu consists of the following options: File Info, Save, and Close. The Close 
pulldown menu will close the File Contents Display Pop-up and all windows derived from the 
window. The Save feature is described in section 5.2.26 “Save Pulldown Menu.”  The File Info 
pulldown menu selection allows the operator to bring up information on the number of Raster 
Image groups, scientific data groups, palettes, Vgroups, LoneVdata, and annotations in the form 
of a File Information dialog as shown in Figure 5-45. 

Figure 5-45. File Information Dialog 

Clicking the OK button closes the File Information Dialog. 

5.2.22 Options Pulldown Menu 

The Options pulldown menu and its Animate images selection becomes sensitized when the 
selected file contains multiple Raster Image Groups. This will cause all the images to be lined up 
and displayed in order in an EOSView - Animation Window. The Animation Window is 
depicted in Figure 5-46, with different frames of an actual animation shown (skull.hdf file). 
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Frame 1 of 40 Frame 4 of 40 Frame 10 of 40 

Frame 22 of 40 Frame 29 of 40 Frame 37 of 40 

Figure 5-46. Animation Window Pop-up 

The Animation Window has the following features: 

•• Closing Animation Window – The Close option on the menu bar of the animation window 
will cause the animation window to close. 

• Palette – see Section 5.2.10 for a description of the Image Display palette. 

•• Modes -- There are three modes of animation. These modes may be selected by selecting the 
Options - Modes options of the animation window menu bar. 

−• The first option "Stop at end" will display the images until the last image or first image is 
displayed. This is based upon what direction was selected for animation. 

−• The second option "Continuous run" will cause the animation to go into an endless loop 
in the direction selected until the stop button is pressed. 

−• The third option "Bounce" will cause the animation to run back and forth in forward and 
reverse order until the stop button is pressed. 
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•• Speed Control -- The speed control slider will adjust the speed of the animation to the 
desired speed. Moving the slider in the "+" direction will increase the animation speed while 
moving the slider in the "-" direction will cause the animation to decrease in speed. 

• Window – see Section 5.2.23 “Window Pulldown Menu.” 

• Help – see Section 5.2.25 “Help Pulldown Menu.” 

•• Start/Stop Buttons -- There are five buttons centered underneath the animation image. The 
five buttons are labeled "<<" "|<" "||" ">|" and ">>". These buttons are known as the 
Start/Stop Buttons. 

− The button labeled "<<" will cause the animation to begin in reverse direction. 

− The button labeled "|<" will cause the animation image to decrease by one frame. 

− The button labeled "||" is the Stop button and will cause the animation to stop. 

− The button labeled ">|" will cause the animation image to increase by one frame. 

− The button labeled ">>" will cause the animation to begin in forward direction. 

The mode of operation of these buttons will be controlled by selecting the Modes option on 
the menu bar. 

5.2.23 Window Pulldown Menu 

The Window pulldown menu lists all windows which are currently open. Any window selected 
from this list will be shuffled to the top. Figure 5-47 shows the Window pulldown menu 
provided when the EOSView Main Window, orbital.hdf, rainbow.hdf and skull.hdf files 
are open. 

Figure 5-47. EOSView Main Screen Showing Window Pulldown Menu 
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The Window pulldown menu provides the same function on all other screens on which 
it appears. 

5.2.24 Attributes Pulldown Menu 

The Attributes option contains one pull-down menu item “Global….” which brings up a text file 
window (shown in Figure 5-48) with a list of attributes (e.g., parameters, values, version 
numbers) for the entire file or brings up a dialog which states that there are no attributes 
available. 

Figure 5-48. Text Display Pop-up 

From the text window, the operator can do the following using the pull-down menus: 

• File – exit the window 

•• Font – select from a list of fonts (e.g., courier, Helvetica). A box showing what the text 
looks like based on the selection is provided. 

•• Style – select from a list of styles (e.g., normal, bold, italic) and point sizes (e.g., 8 pt, 
10 pt.) 

• Help – see Section 5.2.25 “Help Pulldown Menu.” 
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5.2.25 Help Pulldown Menu 

The Help option contains a pulldown menu with the following selections: help on context, on 
help, on window, keys, contents, index and version. 

Help On Context – turns the mouse pointer into a “?” which can be clicked on an area of 
interest, bringing up help text for that item. 

Help On Help – tells the operator how to use the EOSView on-line help feature (see Figure 5­
49) to help understand how to navigate through the Help system using the on-line 
hypertext system. 

Figure 5-49. EOSView On Help Pop-up 

•• File – allows the operator to exit the On Help window. Print and Print Setup are not 
available. 

• Edit – allows the operator to Copy, Copy Part of a Topic, or Copy as Wrapped 
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• Navigate – allows the operator to search for a topic, go to a specified topic, bookmark 
items of interest, go forward and back to a topic (these items are available in the form of 
pushbuttons at the bottom of the screen), and view a previous or next topic. 

• Help – provides help on how to use help and “about help” (not functional). 

The On Help window provides the following pushbuttons: 

• The "Search…" button provides a way to search the EOSView Help system in one of 
two ways. The operator may select to search by Topic in which case a list of topics will 
be displayed for the operator to choose from or the operator may select search by 
Keyword in which case the operator will be presented with a list of keywords from which 
to choose. 

• The "Go To..." button allows the operator to move to one of five topics: 

1. Index - the help described in the Help - Index selection from the menu bar. 

2. Glossary - a defined glossary of selectable terms common to EOSView. 

3. the help described in the Help - Contents selection from the menu bar. 

4. the help described in the Help - On Keys selection from the menu bar. 

5. any marked page (see below). 

•• The "Mark" button allows the operator to mark a page. Once the page is marked the 
page appears in a list box in the "Topic Go to Dialog" box. The marked page may then be 
selected and immediately recalled. The "Mark" button will appear as "Unmark" when 
viewing a marked page. 

•• The "Unmark" button allows the operator to unmark a marked page. If the operator is 
currently viewing a marked page an "X" appears in the check box labeled "Marked:." 
Pressing the "Unmark" button will cause the "X" to disappear and the page will not 
appear in the list box of the "Topic Goto Dialog." 

•• The "Back" button will return the operator to the previously viewed page. The operator 
should think of the help system as a book. The back button will only appear sensitized if 
the previously viewed page would be logically backward from the point of current view. 

•• The "Forward" button will move the operator to the last forward page viewed. The 
operator should think of the help system as a book. The forward button will only appear 
sensitized if the previously viewed page would have a page number greater than the page 
being currently viewed. 

Help On Window 

The Help On Window is the same as the Help On Index Window shown below. 
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Help On Keys 

When Help On Keys is selected from the Help pulldown menu, the following message will 
appear in a Keys Window: “EOSView uses no special keys to traverse through the program. To 
navigate through EOSView simply use the mouse and click on the options that are desired.” 

Help On Contents 

The Help On Contents window tells the operator that EOSView is a tool written to assist 
operators view the contents of HDF files and that it is capable of displaying the contents of files 
containing HDF-EOS data. More help can be obtained by selecting the topic desired (see figure 
5-50). 

Figure 5-50. Help On Contents Pop-up 

Help On Index 

Selecting Help On Index brings up the Index window shown in Figure 5-51. This pop-up 
presents a list of each EOSView window and a list of hypertext help items. 
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Figure 5-51. Help On Index Pop-up 

Help On Version 

Selecting Help On Version from the Help pulldown menu brings up the dialog shown in 
Figure 5-52. 

Figure 5-52. Help On Version Dialog 
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Clicking on the Help button takes the operator to the Help on Contents screen (figure 5-49). 
Click on Cancel to close the dialog. 

5.2.26 Save Pulldown Menu 

The Save option allows the user to save the contents listed in the window to an ASCII file. 
Selecting the Save option will display the File Save Dialog (Figure 5-12). Upon entering a 
unique file name the contents of the window will be saved to an ASCII file exactly as they are 
listed in the window. This Save option is different from the EOSView table save option 
(described in section 5.2.8) in that there is no option to save in binary format. This option exists 
in EOSView windows which incorporates a scrollable text list as the main window function. 
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